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April Fools!

This isn’t the Editor! It’s the Assistant Editor.

As you can imagine, sometimes we’re all at a loss
for words. So it is with this column. I don’t think I
could write a column every single month. Heck, I
have trouble with the welcome column for the
Graphics Special Editions, and I’m only working on
my third! My point is, I want to congratulate parnote
on his awesome writing from month to month. I don’t
think I could do it.

I registered on the PCLinuxOS Forum on August
23rd of 2006 (it was actually my birthday). I’ve been
here ever since. I’ve met loads of wonderful people
(on the forum, anyway), and I hope many of them
are good friends. Many of the forum members that
were here when I registered are still here, and very
helpful to those of us who aren’t quite experts yet.
Yes, I’ve been here for nearly 16 years, and I still
don’t consider myself an expert! I knew next to
nothing about computers when I started - I got my
first computer in 1995 - and have learned a lot, but
I’m still amazed at all the huge gaps in my
knowledge.

When the idea for the magazine came up, with our
friend Tim Robinson as editor, I signed on to be a
proofreader. I figured since I had been a teacher, I
could at least check grammar and spelling on an
article (not content, because in most cases, I didn’t
know enough). I’ve been on the magazine staff ever
since, except for a short break in 2009. I even
started writing articles on subjects I know a tiny bit
about. I’ve even ended up doing several series of
articles. Amazing for a newbie, huh? I’m thankful to
parnote, who has continued to encourage my
writing. Hopefully, one of these days I can meet him
and his family in person.

Through the years, we have lost some good friends,
and made some new friends. Some of us have more
problems than we used to, and some are doing all
right. I miss the ones we have lost and pray for
those who are having problems.

I always enjoy browsing the forum because of the
many comments, screenshots, jokes and photos. A
few years ago, our musically-inclined members got
together, sort of, and did a song. Many played
instruments- drums, horns, etc - and our wonderful
ms_meme wrote and sang. It was beautiful. In the
whole forum, it is amazing how we all get along
together, like a big family. We don’t always agree on
everything, but we recognize each others’ talents
and help each other with our computer and other
problems. Tex and the programmers keep us all
running perfectly (or nearly perfectly), and we all get

updated so our machines run great most all the time.
We cheer each other on, sympathize with problems
or mourn with someone who has lost a loved one.
One big happy family.

********************

This month’s cover, fittingly for a Linux magazine,
celebrates World Penguin Day on April 25.

********************

As parnote says, and it is my wish too, I bid you
peace, happiness, serenity, prosperity … and
continued good health!

DONATE
TODAY

Help PCLinuxOS
Thrive & Survive

From The Assistant Editor's Desk...

https://www.patreon.com/pclinuxos
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by Matt Hartley (ctsdownloads)

I like to believe I have a pretty decent marriage. See,
my wife is a Mac user. And with this comes the
benefit of being able to interact with iMessage on
her iPhone. So in the spirit of "one-upping" my
smarter half, I decided to see what was available to
PCLinuxOS users. After all, surely I could duplicate
her ability to interact with her text messages on her
computer!

After a few minutes of digging around, I realized that
using a Linux tool called KDE Connect would fit the
bill quite nicely.

What is KDE Connect?

KDE Connect is designed to blur the lines between
your KDE desktop environment and your
smartphone. One simply needs to install KDE
Connect onto their PCLinuxOS computer and then
repeat the process on their smartphone. In my case,
I am an Android user. So I looked up KDE Connect
on the Google Play Store on my Android phone and
installed it. Once set up, KDE Connect allows me to
get all my Android alerts on my home computer
running PCLinuxOS.

Why would I want to install KDE Connect?

Everyone reading this may have different ideas
about how KDE Connect might benefit them.
Speaking for myself, I use it because of the following
features.

- Being alerted to my text messages and reply to
them without having to grab my phone.

- Easily send files back and forth without needing
to do so using Bluetooth.

- Locate my phone when I lose it by making it ring
using KDE Connect on my laptop.

Now there are other features I don't use that you
might find interesting.

- Share Desktop and phone copy/paste
clipboard(s).

- Slideshow controls for your desktop using your
phone.

- Remote mouse control from your phone to
manage the cursor on your desktop.

- Receive remote key presses from your computer
to your phone.

- Managing file system access between devices.

It's important to remember that features like desktop
text messaging access and ringing your phone to
locate it will require you to grant access from KDE
Connect on your phone. I recommend only giving
access to those services on your phone you plan on
using.

Installing KDE Connect onto your PCLinuxOS
(KDE desktop) computer

The first step to running KDE Connect is to install it
onto your computer. Start by opening Synaptic and
searching for KDE Connect. Once the search is
complete, you will see something that looks a lot like
this at center top.

Installing the package for the handbook is optional.
For my PCLinuxOS installation, I decided to install
everything seen in the image below. The two most
essential packages we're installing here are
kdeconnect-kde and indicator-kdeconnect.

Once I've marked my packages for installation, I
clicked apply to begin the install process. If the KDE
Connect indicator doesn't appear immediately, you

KDE Connect On PCLinuxOS
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will want to reboot or log off, log in to allow the
changes to take effect.

Installing KDE Connect onto your Android phone
or tablet

The phone I'm using is my Google Pixel 5, fully
updated with the latest version of Android. I imagine
this will also work on older Android devices.
However, I recommend making sure you're using the
latest version of Android available for your mobile
device. I've heard there is a limited version of KDE
Connect for iPhones, but I have had no personal
experience with it.

On your Android phone, open up the Google Play
Store and search for KDE Connect. Then install it.
Once the installation is completed, choose to open
the app.

After you've opened up KDE Connect on your
Android phone, you'll be presented with a similar
screen to this one below. Note: your PCLinuxOS
computer and Android phone must both be on the
same network. Otherwise, your available devices
won't show up.

Your next step is to "pair" your Android phone to
your PCLinuxOS computer. No Bluetooth is used for
this process. The entire pairing process will take
place over your local network. For my installation, I
grabbed my phone and clicked on the device name
shown above.

Once you've clicked the pairing button, your desktop
computer is going to alert you that your phone is
trying to pair to your computer. Choose the accept
option, and you're now connected (right, top).

The next steps are critical as they allow permissions
to provide seamless functionality between the two
devices. Take a look at the following image located
below. This is KDE Connect on my phone.

Anything listed under "Some plugins need
permissions to work" is not set up to communicate
with your computer yet. You'll need to click each
phrase to grant permissions. In my case, the only
phrases I needed were "Send SMS" and
"Connectivity Report."

KDE Connect On PCLinuxOS
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Note: You may see completely different plugin
permissions, so read each entry carefully and grant
those you wish to allow your computer to interact
with.

Learning to use KDE Connect

Assuming everything went as it should, left-clicking
on the KDE Connect indicator for PCLinuxOS should
display something very much like this below.

This indicator gives me the name of my phone, the
battery level for the device, and a menu for
additional options. This opened indicator can also
read any missed pop-ups from your phone
notifications as they happen to come in.

Now let's click on the menu to see what options are
available. Note, remember the permissions we
granted previously from the Android phone? What is
available in this menu will be based on the
permissions you decided to select previously.

I can share a file with my phone based on the
permissions I granted. I can ring my phone (to locate
it), and the SMS Messages option is where I would
manage my text messages. I can also browse the
file system on my phone and share files/images with
it.

Pro tip: If anything in this menu isn't working, it's
usually because you forgot to grant the needed
permissions for each function from the Android
phone's KDE Connect app. For example, "File
system expose" and "Share and receive."

Now let's left-click our KDE Connect indicator again,
select the menu as shown two images above, and
choose SMS Messages. Assuming your phone and
computer are both connected to the same network,
your phone isn't completely asleep; this should bring
up something like this image below.

Sending and Receiving text messages on KDE
Connect

While the contact names might not make it through
transit to your computer, each phone number and
relevant messages will. Click on one of the entries to
bring us to the next screen.

KDE Connect On PCLinuxOS
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Here you have your messages from this person, the
ability to reply to them, and even insert images for
MMS messaging. Before we get too excited, there is
one "gotcha" to be aware of before going further.
When composing a message to be sent via SMS
(text message) to this recipient, the message will be
shown as "sent" in this window. However, it won't
actually be sent until I unlock my Android
smartphone. Once I unlock my phone, it usually
sends the message within a couple of seconds.

Viewing and Dismissing Android notifications

Viewing incoming notifications from your Android
phone is a snap using KDE Connect. In the image
below, I have an incoming email that my Android
phone's email client. Notice the pop-up directly
above the KDE Connect indicator.

When this happened, I was engrossed in Barney
Miller and missed the notification. No problem,
simply left-click on the KDE Connect indicator to see
the message. This works with incoming app alerts,
email, and text messages (center, top).

Now I can see what the missed alert message was.
Additionally, I can choose to dismiss the single
message, or if there are multiple messages, I can
dismiss them "in bulk." The X opposite of
Notifications is a bulk dismiss and the X opposite of
the email alert dismisses that alert only.

Sending and Receiving files to your Android
phone or PCLinuxOS computer

In the image below, you can see an image file I have
selected to be sent from my computer to my Android
phone. I simply locate the file in question, right-click
on it, and choose "Send to device."

Now had I paid closer attention, I could have
achieved the same result by choosing "Send to
'Pixel 5' via KDE Connect." The good news here is
either approach from this menu dialog will send the
selected file to your phone.

To receive files from your phone to your desktop,
you would reverse the process. Choose your share
options for the file from your Android phone. Select
KDE Connect as the sharing tool from the phone's
sharing options.

Once you've shared the file with your computer,
you'll see your indicator display something similar to
this on next page, top left.

KDE Connect On PCLinuxOS
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PCLinuxOS being awesome, you will have already
selected Gwenview to open any incoming images
from your phone.

Closing Thoughts

Wrapping up this article, I figure I would address
some common issues you might face.

KDE Connect indicator says that your phone is not
connected.

- Check to make sure your computer is connected
to your home network.

- Is your phone asleep or turned off? Turn it on or
unlock it, then check your indicator on the
computer again.

- KDE 'SMS Connect' is stuck loading messages.
Unlock your phone, close SMS Connect and
reopen SMS Connect.

- Everything is just super slow. Usually, this is
network speed-related. This is especially true on
saturated home networks.

There you have it. Connect your Android phone to
your PCLinuxOS computer. This should also work
with Android tablets as well. Enjoy!

About the author

I’m the community manager for the Old School Community on
Locals. I handle the community management elements of
OldSchool.Locals.com. Additionally, I have worked with Linux
desktops for well over a decade. My operating system
experience consists of both Windows and Linux operating

platforms. I’ve also worked as a podcast producer, co-host, and
technology writer. For general inquiries, you can reach me at
matt(at)matthartley.com.

Screenshot ShowcaseScreenshot Showcase
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Posted by Ximru, March 6, 2022, running Mate.

http://www.pclinuxos.com
http://www.scribus.net
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by Paul Arnote (parnote)

As I wrote last month, I recently “discovered” podcasts. This has led me to
renewing my “relationship” with MP3 files. Last month, I wrote about resampling a
collection of MP3 files so they all fit on a 700MiB CD-R that I can play in my
truck’s MP3 CD player.

As you can imagine for something that is “new” to any noob, I have a lot of
“catching up” to do when it comes to podcasts. So, I’ve spent some time
exploring, downloading some to my computer, while adding others to my “lists” on
the various services that offer podcasts.

One thing that I noticed is that some of the podcasts have each “episode” or
“chapter” displaying the cover art for that particular podcast. Others, though, only
display the bland “generic” MP3 icon in my file manager (Thunar). Hey! I want
those to have pretty pictures on them, too!

Notice how the icons for the MP3 files at both ends of the image are the generic
MP3 icon used by my file manager. But then look at the nice, colorful, bright
images that represent the three icons in the middle. This is called “album art.”

None of the “pretty pictures” are displayed on my truck’s MP3 CD player. It
couldn’t care less. But, when I view the files on my computer, having the MP3
files all displaying the same cover art (or album art) lets me know that this
particular group of MP3 files are all part of one bigger package. It also helps them
stand out from the crowd, so to speak.

So, I embarked on a “mission” to figure out how to add album art images to my
MP3 files. Some of the solutions I found weren’t … solutions. The method(s)
didn’t work. That is, until I tried one method that I tried to steer away from initially.
In the end, it ended up being the easiest solution.

That solution was to use ffmpeg to embed the album art into the MP3 files. What
caused me to steer away from it initially was a couple of comments that made

sense to me at the time. They were along the lines of “Using ffmpeg to insert
album art into a MP3 file is like using a sledge hammer to drive a tack.” Another
criticism warned about the risks of re-encoding MP3 files, since the MP3
compression algorithm is most assuredly a lossy compression method. That
means that every time you re-encode a MP3 file, you risk losing more and more
sound fidelity. Fortunately, with ffmpeg, that last criticism is easy to circumvent.

So off to the bash drawing board I went! Just like with last month’s MP3 Bitrate
Convertor script, I wanted to create a bash script that could run either as a
standalone script, or that could also be tied to a custom action in Thunar (which is
primarily how I would use it). It also had to have a GUI element to it, to help
insulate those who prefer to stay away from the command line… well, away from
the command line. The script turned out to be much easier than I anticipated.

Below is the script. As you can see, it’s not very long. It’s only 18 lines, and that’s
counting five blank lines. You can download it from the magazine website, or you
can just type it in as you see it here. The line numbers are there just to delineate
the lines of the script, and shouldn’t be entered if you are typing it. The entire
script is only 534 bytes long, so I doubt you’ll go over any speed limits or
download quotas by downloading it. The file is named mp3-album-art.sh.txt.

1. #! /bin/sh
2.
3. n=1
4.
5. img="$(zenity --file-selection --title "Select the album art

JPG, PNG or WEBP file" --file-filter="*.jpg *.png *.webp")"
6. if [ $? == 1 ]; then
7. exit
8. fi
9.

10. for file in $@; do
11. echo "# Processing file: $file"
12. ffmpeg -i "$file" -i $img -map_metadata 0 -map 0 -map 1
-acodec copy out-"${file#./}" && mv out-"${file#./}" "$file"
13. echo $(($n * 100 / $#))
14. let "n = n+1"
15.
16. done | (zenity --progress --title "Adding Album Art..." --
width=450 --height=100 --percentage=0 --auto-close --auto-kill)
17.
18. exit 0

Add Album Art To Your MP3 Files With Ease

https://pclosmag.com/html/Issues/202203/page01.html
https://pclosmag.com/Misc-Downloads/mp3-album-art.sh.txt
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When you download it to your computer, place it in the directory where you store
your bash scripts, remove the .txt file extension, and make the file executable.

So, let’s look at what’s going on in this bash script. Of course, since it is a bash
script, it starts off with the typical bash shebang on line 1. Line 3 sets up an
integer in the variable “n”, which will be important later on when we are displaying
the progress dialog box.

Lines 5 through 8 display the file selection dialog box. This is where you will
select the image to embed into your MP3 file as album art. Keep in mind that your
MP3 files will “grow” by the size of the album art file, so choose something on the
smaller side. This may require you to resize your album art image. Also, your
album art image must be either in JPG, PNG or WebP image formats.

Lines 10 through 16 sets up a for-do loop to walk through all of the files provided
to the script as command line arguments. With line 11, it then also sets up the
information to display in the progress dialog box.

Line 12 is where the “magic” happens. Ffmpeg is launched, with both the input
MP3 file and the selected graphic file imported. The most important part of the
ffmpeg command is the -acodec copy parameter, which tells ffmpeg to merely
copy the audio information, rather than re-encode it. This allows us to avoid
having to re-encode the audio file, and risk further audio quality degradation. The
rest of the ffmpeg command line options write out a temporary file, and then copy
that temporary file back into the original file.

Line 13 increments the progress dialog box as it works through multiple files. Line
14 increments the integer that we set up in line 3, as it keeps track of where it is
in the list of files to process.

Add Album Art To Your MP3 Files With Ease
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Line 16 closes out the for-do loop, and displays the Zenity progress bar dialog
box, so you know where in the process you are. Line 18 exits the script cleanly.

Using The Script

Of course, the script runs from a command line, as intended, with a full graphical
interface … which consists only of a Zenity file selection dialog box. As is my
usual goal, I also want to be able to run it from a custom action in Thunar. As I
stated last month in the MP3 Bitrate Convertor script article, this should also be
able to function in a similar manner in Caja on the Mate desktop, or in Dolphin on
KDE Plasma. Since I don’t run those desktops and haven’t for a while, I’m no
longer familiar enough with how to add them to those file managers’ context
menu to walk you through it. There are plenty of external resources that cover
how to do so, anyways.

In Thunar, go to the Edit > Custom Actions… menu and click on the “+” symbol
that is at the top of the row of buttons on the right side of the dialog box. In the
“Create Action” dialog box (above), under the “Basic” tab (left), fill in the Name
(which will be the menu item name that will appear in your context menu). I
named mine “MP3 Album Art.” You can add a brief description in the “Description”
field, if you want. It’s not required, but may be appreciated if you go back in to
look at it eight months from now. On the “Command” line, enter mp3-album-
art.sh %N. I keep all of my bash scripts in my ~/bin directory, which has been
added to my $PATH statement. That way, my scripts can be located and run

without having to provide a fully qualified path to my bash script. Otherwise, if you
don’t have your bash scripts stored in a directory in your $PATH statement, you’ll
have to provide a fully qualified path to where you stored your script. Under the
“Basic” tab, you can also choose an icon to display and represent your script.

Under the “Appearance Conditions” tab (right), enter *.mp3;*.MP3 on the “File
Pattern” line, and check the box next to “Audio Files.” Click OK and your new
Thunar custom action will be saved.

Caveats

You’ll want to keep your image files as small as possible, of course. Watch your
file sizes of your album art, because when you embed the image into your MP3
file, your MP3 file will grow by that much, as a general rule. So, you might have to
resize your image file to something smaller. Some album art you download can
be as large as 500KiB, which is way too large to be adding to your smaller MP3
file. Usually, resizing your image file to something between 250 and 300 pixels in
width should be sufficiently large enough to see well, but shrink the file down to a
much more reasonable size.

While you can use PNG and JPG files for your album art, you might want to opt
for images in the WebP format. They are typically significantly smaller than either
PNG or JPG files. If you’re unfamiliar with WebP images (I was until very
recently), you can read up on them in the WebP article, elsewhere in this issue of
the magazine.

Summary

Adding album art for your MP3 library can be fun. At the very least, it can brighten
up your file manager. As an added bonus, your album art will be displayed in VLC
or Parole or any of your other audio file players, instead of a blank, empty screen.

Everyone needs a little splash of color and a sense of belonging. Adding album
art to your MP3 files helps keep all of the files from one “album” appearing the
same, so you know at a glance that they all belong together.

Add Album Art To Your MP3 Files With Ease
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This is a staple in many Ukrainian homes, a bowlful
of sweet, sour and savory flavors.
Serves: 4-6

INGREDIENTS:

1 pound beef shank
4 cups onions, chopped
4 cups chopped celery
3 cups diced carrots
1 - 2 cups chopped cabbage
1 or 2 beets, cut into strips
1 small can tomato paste
1 tsp vinegar
1 tsp sugar
2 or 3 potatoes, diced
1 fresh tomato
1 garlic clove
2 bay leaves
Kosher salt and freshly ground black pepper as
needed

DIRECTIONS:

Boil roast in a little water until done. Remove from
the pot and chop into small pieces. Save broth.

Pour several tablespoons of oil in a skillet and saute
onions, celery, and carrots. Pour sauteed vegetables
into reserved broth. Add beef back to the broth and
put into the chopped cabbage. Turn on low heat and
simmer.

In a skillet place a little broth, tomato paste, and cut
up beets. Cook until beets are tender. Add vinegar
and sugar.

Pour beef mixture into pot, add the chunked
potatoes, and bring to a boil, boil for 10-15
minutes or until potatoes are tender.

Cut up the tomatoes into tiny pieces and add
1/2 tsp salt. Press garlic cloves and add into
tomatoes, then pour into the pot. Continue
simmering for 10-15 minutes. Add bay
leaves and let set for up to an hour to blend
flavor.

Serve with sour cream.

NUTRITION:

Calories: 479 Carbs: 28g
Sodium: 500mg Fiber: 5g
Protein: 32g

Defending Your Rights

In The Digital World

PCLinuxOS Recipe Corner

Ukrainian Borsch

https://www.eff.org/
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Available in the following desktops:

KDE LXQt Xfce

MATE Trinity

Enlightenment

Posted by kalwisti, March 7, 2022, running Mate.

http://www.pclosusers.com/services-signup.php
http://www.pclinuxos.com
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by Meemaw

I’ve been back to YouTube, watching tutorials! I
found one from the channel Logos by Nick which
has one called Vector Abstract Background. I
thought I’d share it.

Create a rectangle for the background in your
desired size. The tutorial used 1280 x 720 px.
Choose Path > Object to path.

For fill, choose Mesh Gradient. Click each corner
and set the fill on each a different color.

Create a new layer above the one you have. On this
layer, create a little circle, fill it with a color you can
see over the ones you have and place it in the upper
left corner of your background. Choose Path >
Object to path. Align the dot with the top and left
edge using the Align and Distribute dialog.
Duplicate the circle for each corner and make sure
they are aligned vertically and horizontally in the
corners.

While you are duplicating, put several across the top
and bottom and down each side, all aligned with the
border they are along (top to top, etc). An easy way
to do this is to duplicate one, and while you are
dragging it to a new location, press the <SPACE>
bar several times. Each time you press the
<SPACE> bar, a new circle will appear.

After you get them all aligned, duplicate one again,
and pressing the <SPACE> bar several times,
arrange the circles randomly inside the rectangle
(top, right).

At this point, you want to lock Layer 1 so it can’t be
selected. Select everything else, and go to
Extensions > Generate from path > Voronoi
Diagram. When the window appears, choose
Delaunay Triangulation for the type, and

Automatic from selected objects under Bounding
Box. Make the colors Black stroke and no fill.
Press Apply. It should look similar to this:

Now, select everything on Layer 2, then hold the
<SHIFT> key, and deselect the lines. Press
<DELETE> to delete the circles, which you no
longer need (next page, top left).

With the wire frame as it is, we can’t color it the way
we want. Choose your wire frame and click on Un-
Group selected groups (next page, left).

Deselect all, then select only one triangle. Using
your color picker tool (the eye dropper) click inside

Inkscape Tutorial: Create An Abstract Background

https://www.youtube.com/channel/UCEQXp_fcqwPcqrzNtWJ1w9w
https://www.youtube.com/watch?v=7hcxuwDKo6I
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the triangle. It will fill in with a shade from the
background that is under that particular triangle.
We’ll want to do that with each triangle. There are a
couple of ways to do this. In the YouTube video, he
said you can use the function keys to toggle back &
forth between the select tool (F1) and the color
picker (F7), but that doesn’t work for me. You can
choose each triangle and then choose the color
picker to color it. You can choose one triangle, color
it, and then press <TAB>, which will move your
selection to another triangle. It might jump around a
lot, but you’ll get there. Anyway, you want to select
and color each triangle. If you aren’t sure if you got
them, turn off the visibility on layer 1. See, I missed a
couple (center, top).

When you get them all filled, you can actually delete
Layer 1 as you no longer need it (center).

Now, select all, and in the Fill & Stroke dialog, or at
the bottom of the main window, set the Stroke to
none, then group them all.

You might see some white spaces between your
triangles. If you do, duplicate your drawing a time or
two, and it seems to take care of them. Export your
drawing and you’re finished.

You can use bright colors or pastels. It looks pretty
cool, I think.

A magazine just isn't a magazine
without articles to fill the pages.

If you have article ideas, or if you
would like to contribute articles to the

PCLinuxOS Magazine,
send an email to:

pclinuxos.mag@gmail.com

We are interested in general articles
about Linux, and (of course), articles

specific to PCLinuxOS.

 Inkscape Tutorial: Create An Abstract Background
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by Paul Arnote (parnote)

Would you believe me if I told you there was a newer graphics file format that had
better compression than JPEG files with comparable image quality? Would you
believe me if I told you there was a newer graphics file format that supported
transparency and lossless compression just as good as – if not better than –
PNG files? Would you believe me if I told you there was a newer graphics file
format that supported animation better than GIF files?

Well, believe it. And it isn’t three newer graphics file formats. It’s just ONE, that
does all of these things. You’ve likely seen images from the graphics file format
around on websites you’ve visited. It’s called WebP.

Why I’m Writing This

I have been increasingly encountering WebP graphics as I traipse around the
web. Quite by accident, I discovered that GIMP and ImageMagick could see and
work with WebP graphics, but not much else but my web browsers. Certainly,
Scribus (which is what we use to layout the PDF of the magazine) cannot see or
use images in the WebP format. So any WebP images that I needed to use had
to first be converted either into JPG or PNG formatted images. One thing I
noticed almost immediately was that the WebP images appeared to be high
quality images, and they were typically significantly smaller file sizes then the
JPG or PNG files I converted them into. It piqued my curiosity, to say the least.

If you recall, I recently got interested in podcasts. Most of the “cover images” for
the podcasts I’d find and download were in the WebP format. But, to view them, I
either had to load them into my web browser, or convert them to the much more
common JPG or PNG formats.

So, I wanted to know more about this mysterious, “new kid on the block”
graphical file format. What I discovered is contained here in this article, that I’m
sharing with you.

WebP History (In A Nutshell)

In February 2010, Google completed a purchase of On2 Technologies for just
under $125 million in Google stock shares. On2 Technologies main area of
interest was in video compression technologies, such as VP3, VP4, VP5, VP6,
VP7, and VP8. These video compressors offered high quality images with (at the
time) maximum compression, resulting in lower file sizes.

Google subsequently tweaked the VP8 video compression library, and open
sourced the code as the WebM video compression library. Smaller files meant
less traffic over already-bulging and overloaded internet data servers, improving
throughput. The WebM video compression library is licensed under the BSD free
software license.

The WebP graphical file format is a sister project of WebM, derived from VP8,
using technology and techniques from the video compression library. Like its
video big sibling, WebP is open source, and is released under the BSD free
software license.

WebP was first announced by Google in late September 2010 as a new format
for lossy compression of true-color graphics on the web that was capable of
producing smaller files than JPEG, with comparable quality. In October 2011,
Google added support for animation, ICC support, tiling, and XMP and EXIF
metadata. Then, in November 2011, Google announced support for a new
lossless compression mode, as well as support for transparency and alpha
channel in both lossy and lossless modes. When Google made the
announcement for the lossless compression mode, it reported roughly a 45%
reduction in file size versus the same image in PNG format.

The desire for high quality images with maximum compression is easy to
understand. The greater the compression, the smaller the files. And, the smaller
the files, the less bandwidth is used, and the faster web pages load.

It has taken a little while, but today, there is support for WebP graphics in the
most popular web browsers that serve over 96% of the web browser users. Safari

WebP Graphics: The "New" Kid On The Block
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was one of the last to add support, as recently as 2020. Meanwhile, Firefox
originally considered supporting WebP graphics as early as 2013, but official
support didn’t come about until January 2019 (with Firefox, Pale Moon, and
Waterfox). All the Chrome and Chromium-based browsers (including Opera,
Edge, etc.) officially support WebP, as does Gnome Web, Midori, and Falkon.

Support also exists for WebP graphics in many graphics software packages.
XnView, GIMP, IrfanView, gThumb, and ImageMagick all support it natively.
GIMP’s support is builtin from version 2.10, but was accomplished in previous
versions by way of a GIMP plugin. That plugin “shipped” with GIMP 2.9, and was
downloadable for GIMP 2.8 and earlier versions. The commercial Adobe
Photoshop also natively supports WebP graphics, from version 23.2 and up.

Users can also count on support for WebP graphics from ffmpeg, Gmail and
Google Photos. Telegram Messenger uses WebP graphics files to display their
“stickers,” while Signal uses the graphics file format for their non-animated
stickers. Largely unsupported (natively) by content management systems,
support can usually be added on with the addition of a plugin. WordPress,
however, supports WebP graphics natively since June 2021.

If you want to dig deeper into the history of WebP graphics, Wikipedia actually
has some great information, as well as information on the more technical aspects
of the file format.

Likely because of the support of all of the major players in the browser market
and among graphics tools, you’re likely to find WebP images supported natively
on PCLinuxOS. A cursory look in Synaptic shows three different versions of
libwebp installed on my computer (libwebp4 from 2013, libwebp6 from 2017, and
libwebp7 from 2021), and I suspect the reason for three different versions of the
same library is to insure backward compatibility. I also found libwebpdemux2 and
libwebpmux3 installed. I installed libwebp-tools to my computer, to give me a
couple of command line tools to use with WebP image files. That installed the
webpinfo and webpmux command line tools for my use.

Finally, since I’m a Xfce user, my go-to file manager is Thunar. I can tell you that,
out of the box, Thunar doesn’t have support for WebP graphics. So, I took a shot
in the dark and installed lib64webpdecoder3 from Synaptic (it wasn’t installed on
my computer previously), and … ta-da! … Thunar now shows me thumbnail
images for WebP graphics. It’s not 100% for all WebP graphics, but it definitely
works for the majority of WebP graphics I’ve “collected” as I’ve prepared to write
this article.

So, How Does WebP Compare?

When researching this article, I found it difficult to find much of anything that
offers a direct comparison of file formats. By now, everyone should be grossly
familiar with the advantages and disadvantages of JPG and PNG files. So, I won’t
rehash all of that information. We all know that the greater the compression with
JPGs, which use a lossy compression (resulting in loss of fine details), the lower
the quality of images and the smaller the file size … and vice versa. PNG files
use lossless compression, which preserves image quality, but typically with a
larger file size than their JPG counterparts.

So … I decided to make my own comparison. While it’s far from scientific, I think
it’s a fairly accurate representation of what a typical user can expect.

To make my comparisons, I loaded a random PNG file (in this particular case, a
screenshot of my desktop from 2020, above) into GIMP, and converted the PNG
image to a WebP image. I did this several times, with each time at a different
WebP “quality” level. Those levels, using lossy compression, are 100%, 90%,
70%, 30%, and 10%. Then, I loaded all of those WebP images and the original
PNG file into GIMP with cascading windows, so we can see the same section of
the image in each case. Each image was zoomed to 400%, so we can see the
individual pixels. The area bounded by the red box in the lower left corner of the
image above is roughly the area we are looking at in the zoomed images below.

The first thing that should be rather evident is the difference in file sizes. To say
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that the file size difference is remarkable is an understatement. Stay tuned. We’ll
talk about several differences all at once.

The next thing that is very evident (to me, anyway) is the quality of the images,
particularly when it comes to preserving detail. So, let’s break this down.

The PNG file is 1.4MiB in size. It is difficult to discern much (if any) difference
between the PNG file and the WebP images at both 100% quality and 90%
quality. Of course, the WebP 100% quality file is only 31.1% of the size of the

PNG file. And, the WebP 90% quality file is only 17.3% of the size of the original

PNG file. Those are, without a doubt, very significant savings in file size.

When we get to the WebP file done at 70% quality, you can just start to see some
degradation of image quality, but it is very minor. Zoomed back out from a 400%
zoom to a normal, 100% zoom of the image, it is very difficult still to tell much (if
any) difference between the original PNG file and the 70% quality WebP file.
Most importantly, the WebP 70% quality file is only 8.4% the size of the original
PNG file! If you’re a web author, these savings are enormous, both in bandwidth
usage and in how fast your images load.

Once we get down to a quality setting of 30%, the loss of image detail becomes

WebP Graphics: The "New" Kid On The Block
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fairly obvious. But when zoomed out to a 100% viewport, the loss of image detail
is hardly noticeable. The WebP image done with a 30% quality setting, though, is
only 4.4% of the size of the original PNG file. With a quality setting of 10%, the
WebP image’s loss of quality becomes abundantly evident when zoomed to
400%, as in these examples. But even when you change the viewport to 100%,
the image quality loss is difficult to see, at least with a cursory glance. And,
unless you’re doing side-by-side comparisons like I’m doing here, I question how
many people would notice. At the 10% quality setting, the WebP image is only
2.6% of the size of the original PNG file.
So, let’s compare lossless PNG (how do you like that for redundancy?) to

lossless WebP. In the image above, the PNG is on the left and the lossless
WebP image at 90% quality setting is on the right. To me, they look nearly

identical. Unless I already knew (because I created the graphic), I wouldn’t be
able to tell you which one is which. But, what isn’t identical is the file size. The
WebP lossless image is only 67.8% of the size of the original PNG file, or about
⅓ smaller in file size. That is significant, especially when you have multiple
images in a project.

Creating Your Own WebP Images

So, why might you want to create your own WebP images, you might be asking?
Well, if you’re designing a website and need to reduce bandwidth and/or have
images load quicker, WebP would help with that. As a regular user, you could
also save some precious disk storage space by converting some of your images
to the WebP format.

If you want to go “command line commando” with the conversion, you can enter
the ImageMagick command convert to perform the conversion. Your command
line might look something like this:

convert -quality [your-quality-setting] [your-input-image] [your-ouptut-image.webp]

or

convert -quality 80 this.jpg this.webp

Using the command line, it would be a trivial task to set up a bash script with a
for-do loop, and convert multiple files at one time to the WebP format. In fact, I
have a custom bash script I use for converting image files from one format to
another that is tied to a custom action in Thunar that I use all the time. This is the
method I normally use any time I’m converting between graphic file formats.

Google has also provided a command line tool for Linux and MacOS users,
called cwebp. I found it already installed on my computer, but I do not know if it
was there before I installed the libwebp-tools package, or if it was installed when I
installed that package. From the Google Developers page for WebP, they
recommend the following command for converting multiple files to WebP
formatted files:

$ for F in *.jpg; do cwebp $F -o `basename ${F%.jpg}`.webp; done

Of course, their example assumes your “other” files are all JPGs. If you have
PNG files that you need to convert, just change all of the “jpg” references to “png”
and you’ll be good to go.
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However, if you decide to shy away from the command line, you can still create
your WebP images with GIMP. That is how I created the WebP images for this
article, in fact. I did them this way for the article for the sake of consistency. But
you will have to do them one at a time. GIMP does have a batch processing tool
(under the Filters menu item), but that tool doesn’t yet support output files in the
WebP format. Maybe someone with more GIMP-Fu than me can figure out a
different solution, but I don’t see any other option than doing the conversions one
at a time via GIMP.

Load the image you want to convert, then select File > Export as… from GIMP’s
menu. Change the file extension to “webp” and select the “Export” button. You
should see the dialog box shown above. In the dialog box, setting your desired
image quality is your primary concern.

Also note the checkbox in the upper left corner of the dialog box. If you leave it
unchecked, your WebP image will be created using lossy compression (think JPG
files here). However, if you check the Lossless box, your WebP image will be
created using lossless compression, similar to how PNG files are compressed. I
point it out because it’s easy to overlook. I didn’t really notice the option until I
had already converted a few images to WebP with GIMP.

“Other” New Competing Formats In The Wings

WebP isn’t the only new image format poised to emerge. Despite their wide use
and acceptance, there’s a push for formats that compress images better while
retaining more of detail.

The Joint Photographic Experts Group has come up with JPEG XL. Despite
pretty much failing to see previous alterations to the JPEG standard gain traction
(think JPEG2000), they are trying again with JPEG XL. You can recognize JPEG
XL files by their JXL file extension. The new JPEG format is supposed to be
backwards compatible with the old format, and allows for losslessly converting
the older format to the newer one. It also adds support for transparency (alpha
channels). Having been granted ISO/IEC status (ISO/IEC 18181), you can read
more about the new JPEG XL format by clicking on the first link in this paragraph.
Not everyone is exactly thrilled by the new format.

Good luck trying to view JXL files on PCLinuxOS. While I have quite a few
graphics utilities and viewers installed on PCLinuxOS, I couldn’t find any capable
of displaying JXL files. Nope. Not even GIMP. ImageMagick, however, will
create/read/write JXL files. Fortunately, Google Chrome can load and display JXL
files, but then you have to do a small modification to Google Chrome, first. On
Chrome’s address bar, type chrome://flags, and then search for “jxl.” Change
the setting from the “Default” setting to “Enabled.” You can also set the same flag
on other Chrome-based/Chromium-based browsers. With the ability to display
JXL files present since Chrome 91, you can use Google Chrome (or other
Chrome/Chromium-based browser) as a JXL file viewer until the other graphics
utilities catch up.
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Mozilla is looking at implementing support for JXL images in the near future, but I
can’t find a timeline on exactly when that might happen. Some of the support is
already present (about:config > search for “jxl” > change support/display from
FALSE to TRUE), but JXL images simply don’t display yet in Firefox.

The image above is from a zoomed in JXL image in the Brave browser. To call
me unimpressed would be an understatement. The lack of sharpness,
pixelation/grain, and general “noise” in the image is really just rather “nasty,” at
least to my eyes. Maybe it’s just the image that I chose, but it’s rather difficult to
find JXL image examples. Unless things improve significantly, JPEG XL files will
be on my radar just as much as JPEG 2000 files are or were. And in case you’re
wondering, that’s not at all.

AV1 Image File Format (AVIF) is another new (and open) image format, based
on the AV1 video format. You’re likely to find better AVIF image support than for
JXL images, since it has been out a little longer than the JXL format. Netflix
published the first AVIF images in December 2018, with the first HDR AVIF
images coming in November 2020. You can read all of the technobabble about
AVIF files from the Netflix TechBlog article, “AVIF for Next-Generation Image
Coding.”

There are quite a few “image slider” files on the medium.com website article
comparing image formats. You can view the one pictured above here. I picked the
image above because my family goes to this location fairly frequently. It’s on the

namesake trestle of the High Trestle Trail multi-use trail in Iowa. It’s my kids’
favorite bike trail to ride, and about three hours from our house. But besides its
personal familiarity, I also picked this image because it represents a difficult
image to typically get really good photos of. There’s a very wide dynamic range
from bright lights to really dark shadow areas, and represents a type of photo
that’s difficult to get really good quality at both ends of that dynamic spectrum.

Support for AVIF files is very good, especially under Linux. Thanks to lib64avif,
currently at version 0.9.1-2pclos2021 in the PCLinuxOS repository, encoding and
decoding AVIF images is trivial. Native support exists in GIMP, Krita, VLC,
IrfanView, XnView and gThumbs, all of which are in the PCLinuxOS repository.
Gnome and GTK+ desktops/apps have full support via the avif-pixbuf-loader
package in the repository, as well. KDE Frameworks added support for AVIF files
to the KImageFormats library in January 2021, which enabled most KDE and Qt
applications to support viewing and saving AVIF files. Google Chrome, Firefox,
and most Webkit browsers (except for Safari) all currently support the display of
AVIF images.

AVIF files typically feature twice the compression of WebP images, and are often
smaller than JXL files, at a higher image quality. To be honest, it makes me
wonder why work is proceeding on further work on JXL files. AVIF files do have
limitations. For one thing, it renders details in water (waves, ripples, etc.) with
something left to be desired. There is an “image slider” file on the Medium
website linked to earlier which illustrates the trouble AVIF has with rendering
details in water.

Still, AVIF files deserve to be on your radar. They offer excellent compression,
while maintaining a fairly high image quality. The BlobFolio article, “JPEG XL, the
New Image Format Nobody Wanted or Needed,” lays out the differences between
AVIF, JXL, WebP and PNG files quite nicely.

Summary

As much as I hate to admit it, I give Google “props” on the WebP format. Heaven
knows how much they’ve taken away from the open source community without
really giving back. Yes, I know they have given back in some ways, but in many
other ways, they have taken way more than they have given back. I, like many
other Linux users, grow weary of Google supporting their various services with
“official” tools for every other platform but Linux. Picasa, when it existed, was
merely the Windows version wrapped in a Wine wrapper. It was the same thing
for Google Sketch. Google is reported to have an AWESOME Linux desktop
client for Google Drive that they use internally, but they steadfastly refuse to
release it (or anything like it) to the Linux community. Internally, Google uses a
customized version of Linux on their multitudes of workstations.
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It’s good that Google open sourced the WebP format. That means they can’t pull
the plug on it just as it gains popularity, as Google is known for doing. That list
can go on for eons. Because it’s open sourced, not only can the open source
community pull together and keep it alive, but they can also contribute to the
project in meaningful ways.

WebP is young as far as graphic file formats go. GIF, JPG and PNG have been
around for quite a long while. I can only hope that WebP picks up increasing
support in the years to come. I can see the WebP format helping to create
smaller file sizes from the PDFs we create with Scribus, should the Scribus
developers decide to implement support for it. And, interestingly enough, The
CrankyZombie noticed that despite Google being a supporter for WebP graphics,
Google Docs does not allow you to use/import WebP graphic files. If you try, you
will get an error message that the image type is not supported.

I can foresee a time when WebP graphic files become the de facto standard on
the web. Much like H.265 video is supplanting H.264 video with superior quality
and smaller file sizes, WebP graphics will someday supplant JPGs, GIFs, and
PNGs on the web with its superior quality and smaller file sizes.

If you’re a person who likes to be on the “cutting edge,” WebP graphics currently,
in my opinion, are the current cutting edge for raster image file formats.

Additional Resources

Wikipedia: WebP

Google Developer’s WebP Reference pages

Adobe CreativeCloud WebP Image Formats page

Hostinger Tutorials: What Is WebP? A Guide For Beginners

DuckDuckGo: webp file format
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by CgBoy

Cryptomator is a useful tool for easily encrypting
any data that you may wish to store online. It allows
you to create a securely encrypted folder, or vault,
containing your files, that you can then upload to any
online cloud hosting service. Cryptomator uses AES
256 bit encryption to ensure that your data is always
kept safe and secure while stored in a vault.

Cryptomator has a sleek, modern user interface
that’s very easy to use. To the left side of the window
is a panel from which you can select a vault from the
list. Clicking on Add Vault brings up a small window
giving you the option to create a new vault, or import
an already created one into Cryptomator. To import a
vault created with Cryptomator, you simply have to
navigate to the directory where the vault is stored,
and load in the masterkey.cryptomator file.

Creating a new vault is a simple and straightforward
task. You’ll have to enter a name and provide a file
location for the vault. Cryptomator allows you to

automatically save your vault to a cloud-synced
directory for online storage providers, such as
Dropbox, Google Drive, OneDrive, etc, depending
on what services you have installed on your system.
You can also choose to simply save the vault to a
custom location. Next, you’ll have to choose a
password for your vault that is at least eight
characters long. Cryptomator also gives you the
option of creating a recovery key in case you forget
your password.

This works by generating a human-readable version
of the vault’s masterkey in the form of a long string
of words. This recovery key you can then save
somewhere secure, and then, if you happen to lose
your vault password, simply input the recovery key
to reset the password. When you’re finally ready, just
hit Create Vault.

This will create a new folder in the location that you
specified, securely storing the contents of the vault,
and always remaining encrypted. You can then
upload this folder to an online cloud hosting service,
knowing that the data it contains will be kept safe
from anyone wanting to access it.

Opening a vault you’ve created is very easy. Simply
select the vault from the side panel, click Unlock,
and provide the vault’s password. Now just hit
Reveal Drive to mount the vault and open it in your
file manager. You can then copy files to and from the
vault as if you were simply accessing a flash drive.

Cryptomator gives you a number of vault options
you can configure, such as a custom mount location,
custom mount flags, and you can set the vault to be
read-only. When you’ve finished accessing a vault,
just click Lock to unmount it. You can be sure that all
your data is safely and securely encrypted within the
vault.

Repo Review: Cryptomator
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Summary

Cryptomator generally worked very well during my
use of it. When using it on KDE Plasma, however, I
did occasionally encounter issues where a vault
would not want to unmount properly, and
Cryptomator would allow you to force-unmount it
(Your data is still kept securely encrypted). I did not
have this issue on other desktop environments,
though. On the whole, Cryptomator is a great option
for anyone wanting a simple way to keep their data
safe when stored in the cloud.
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by Paul Arnote (parnote)

The War On Your Privacy: Monthly Update

To be perfectly honest, things seem to have been
really quiet on this front lately. All of the data worth
vacuuming up has already been assimilated, or
media outlets just aren’t reporting on them as much
as they were. I’m not sure which it is. This section of
the Short Topix article last month wasn’t included,
because there really wasn’t anything to report, which
in some ways, is news in and of itself. So, we got
one month off, but now there are some new “threats”
to your privacy for this month.

RICHMOND, VA: NEW RESEARCH FROM HIVE
SYSTEMS FINDS ANY 8-CHARACTER
PASSWORD CAN BE CRACKED IN LESS THAN
AN HOUR. In its most recent research in password
security, Hive Systems found that any 8-character
password can be cracked in less than an hour
through brute force. Further, any password
containing less than seven characters can be
cracked instantly. These are just two major findings

from extensive research conducted by the
cybersecurity firm.

“While passwords aren’t the only method to keep
your information safe” said Alex Nette, CEO and
founder of Hive Systems. “a strong and unique
password is the best way to stay safe online.”

The research also found that advances in
technology over the past two years have cut the
amount of time it takes to crack a password through
brute force exponentially. In 2020, a complex eight-
character password could be cracked in eight hours
– a number that has now decreased to less than an
hour. The rise in affordable cloud computing has
contributed to this trend.

The use of a password manager for creating and
storing passwords significantly increases the safety
and security of passwords. In fact, a 12-character
password created by a reputable password manager
could take up to 3000 years to crack through brute
force the research found.

“Password best practices have been well
documented, but as technology improves,
passwords become less secure,” said Corey
Neskey, VP of Quantitative Risk at Hive Systems.
“The safest option for consumers is to use a
password manager to create and store all of your
passwords. Never use a password twice, and always
be aware of sites that have had a password breach.
If you reuse passwords, your information can be
stolen instantaneously.”

The table of results – shared thousands of times
across Twitter, Reddit, and other social media
platforms – is available for download here.

IN FEBRUARY, A CHINESE-BACKED HACKING
GROUP NOTED AS APT31 TARGETED EMAILS
AFFILIATED WITH THE U.S. GOVERNMENT WITH
PHISHING ATTEMPTS, according to a
TechRepublic article. The emails, all to Gmail
accounts, were all successfully marked as spam by
GMail. In a subsequent Google blog post on March
7, Google alerted users to a variety of threats
emanating from Russia, Belarus, and China.
Especially with the war in Ukraine raging on, users
are urged to maintain vigilance over their accounts
and data, as cybersecurity experts anticipate an
increase in threat vectors. Sanctions imposed on
Russia may escalate those threats, as they attempt
to circumnavigate those sanctions.

There is no doubt that RUSSIAN THREAT ACTORS
ARE TARGETING UKRAINIAN SYMPATHIZERS
AND THOSE ATTEMPTING TO AID UKRAINE as
the Ukraine-Russian war goes on, according to a
threat advisory from Cisco Talos. Cybercriminals are
attempting to exploit Ukrainian sympathizers by
offering malware purporting to be offensive cyber
tools to target Russian entities. Once downloaded,
these files infect unwitting users rather than
delivering the tools originally advertised.

Do you have “Craftsart Cartoon Photo Tools”
installed on your Android device? If so, you might
want to remove it … now. More than 100,000 users
have installed this “cartoonifier” app from the
Android Google Play Store. THE APP CONTAINS
THE TROJAN “FACESTEALER,” WHICH
ATTEMPTS TO STEAL A USER’S FACEBOOK
LOGIN CREDENTIALS, ALLOWING THEM
UNFETTERED ACCESS TO A USER’S
FACEBOOK ACCOUNT. Security researchers and
security firm Pradeo discovered the malicious app in
the last half of March 2022.

Short Topix: Google Confirms
Browser Attacks, With Explanation
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GOOGLE’S DIALER AND MESSAGING APPS
HAVE BEEN COLLECTING AND SENDING DATA
TO GOOGLE WITHOUT SPECIFIC NOTICE OR
CONSENT, possibly in violation of Europe’s GDPR,
according to an article on The Register. The data
collection does not appear to have an ability to “opt
out,” either. Google has countered that the data is
stored in a hash, and is ONLY used for internal
diagnostics to help figure out problems with the
services. (Anyone want to buy a bridge in Brooklyn
I’m trying to sell?)

New NSA Report On How To Secure Your
Networks

The (U.S.) National Security Agency (NSA) has
released a new report (PDF) on “best practices” to
secure your network against cyberattacks. Called
the “Network Infrastructure Security Guidance,” the
report covers network design, passwords, password
management, remote logging and administration,
security updates, and key exchanges, as well as

services such as SSH, NTP, HTTP, and Simple
Network Management Protocol.

Google Confirms Browser Attacks, With
Explanation

Google confirmed the (obvious) increase in
cyberattacks on Google Chrome and other
Chromium-based browsers in a recent blog post.
They also told users to expect an increase in “zero-
day attacks.”

Since the (long overdue) death of Flash, malware
threat actors have refocused their attention on the
Chromium-based browsers (Google Chrome,
Chromium, Brave, Opera, Microsoft Edge, etc.). The
blog post goes on to explain what Google is doing to
help minimize and mitigate those security concerns.

Surprisingly, the graph provided by Google on their
blog post shows no significant threats to Firefox. And
that same graph shows how much Chromium-based

browsers have taken the place of Flash as an attack
vector.

So, if Google Chrome or any other Chromium-based
browser is reminding you to update, perhaps you
should listen and grab the update.

Sabotage Code Added To Popular NPM Package

The war in Ukraine has spilled over to the digital
world, as well, according to an article on Ars
Technica. One developer of a popular open source
package embedded code that erased files for users
in Russia and Belarus. The software would read the
IP address of the user, and if they were found to be
in either Russia or Belarus, the payload/damage
was delivered. This was to protest Russian
aggression in Ukraine, and the support by Belarus
for that aggression.

Many are calling this software (and any software like
it that performs similar actions) a black eye on the
open source community. Now, instead of apolitical

Short Topix: Google Confirms Browser Attacks, With Explanation

https://www.theregister.com/2022/03/21/google_messages_gdpr/
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software, end users have to wonder if a developer is
going to impose their own belief system upon the
end users. And what if that software was being used
for mission-critical functions … such as life support?
Now, innocent people are being deliberately harmed,
which is no better than the aggression that’s being
protested.

The developer in question has since issued updates
with the offending code removed. While the wrong
has been righted, doubts now exist (especially for
that developer) if future updates will bring further (or
more severe) forms of protest.

First Images From James A Webb Space
Telescope Exceed ALL Expectations

In the planning and construction stage for what
seemed to be forever, the James A. Webb Space
Telescope, launched last December, has finally
reached its destination and is undergoing the
process to fine tune, focus and align its 18
hexagonal mirror segments. Combined, those 18
hexagonal mirror segments combine to make a 6.5
meter wide primary mirror. Extensively covered in
multiple media outlets, the article at Cosmos
Magazine provides an excellent discussion of the
JWST.

Orbiting the Earth at 1 million miles (~1.5 million
Kilometers) at Earth’s Lagrange Point 2, the
telescope is too far away for a service mission, a la

Hubble, were “things” to run afoul. So there was a lot
of nervous trepidation as the JWST mirrors unfolded
and deployed. Then, the lengthy process of aligning
those mirror segments absolutely perfectly began in
earnest.

As a part of that process, the mirror was pointed to a
rather “boring” star that is 100 times dimmer than
can be viewed with the naked human eye. Yes, it’s a
pretty picture of a rather unremarkable star. But what
really got the astronomers and scientists excited was
the background of that image. Each of the little dots
of light that make up that background are dim,
distant galaxies, too dim to be viewed. Yes, those
galaxies are now viewable for the very first time.

Those galaxies pop into crystal clear view,
exceeding the lofty expectations mission designers
have maintained throughout the planning and
construction of the telescope. For all of the
remarkable discoveries that the Hubble Space
Telescope has delivered from it’s near-Earth orbit
(and continues to deliver), the JWST is 100 times
more sensitive. It is estimated that the JWST will
allow astronomers to peer back in time to within a
few hundred million years of the start of the
universe, observing things about our universe never
before seen.

Currently, only the Near-Infrared Camera (NIRCam)
is currently online. The other three scientific
packages are expected to be online by June or July.
Once that happens, JWST mission members are

warning to watch out. This is only the first of many,
many finely detailed images to come from the
platform, which is expected to set a new standard for
astronomical space exploration. In other words, stay
tuned! The best is yet to come!

The PCLinuxOS Magazine Short Topix Roundup

UBLOCK ORIGIN IS NOW THE MOST POPULAR
FIREFOX ADD-ON, according to an article on
gHacks. After landing in the second most popular
spot behind Adblock Plus for quite some time, it has
finally surpassed the former leading add-on. The
content blocker is expected to widen its lead over
Adblock Plus in the coming months.

According to an article on Phoronix, REACTOS IS
MAKING SIGNIFICANT PROGRESS ON SMP
(SYMMETRIC MULTI PROCESSING) SUPPORT.
This support is becoming increasingly important for
today’s hardware, which most often supports
multiple core processors.

Looking for an old article?
Can't find what you want? Try the

PCLinuxOS Magazine's
searchable index!
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V7 has created a new AI-BASED GOOGLE
CHROME PLUGIN THAT DETECTS ARTIFICIALLY
GENERATED PROFILE PICTURES with a 99.28%
accuracy rate, according to an article on PetaPixel.
Called “Fake Profile Detector,” the plugin should be
available for most Chromium-based browsers. Right-
click your mouse on a profile picture and select
“Check fake profile picture” from the context menu.
The results will be displayed in a popup window in
the upper right corner of the web page.

FIREFOX IS FINALLY ADDING SUPPORT FOR
AV1 VIDEO, a full two years after support has been
added to Chromium-based browsers.

A photographer who had been photographing some
of the biggest names in Rock and Roll music since
the 1960s, HAS OVER 3,200 UNDEVELOPED
ROLLS OF FILM sitting in his Boston home. Those
rolls likely contain a never-before seen historical
record of the early days of some of the biggest
names in rock and roll, according to an article on
PetaPixel.

Screenshot ShowcaseScreenshot Showcase
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Compiled by Meemaw

NFL Player Dances The Extra Mile

After Audrey’s father and grandfather both passed
away in 2021, they were having a hard time. The
Father-Daughter Dance at Audrey’s school was
coming up and there was no one to take Audrey.
Audrey’s mother Holly contacted her favorite NFL
player, Eagles safety Anthony Harris, via social
media. She explained the situation and asked
Anthony if he could help by taking her. Surprisingly,
he was willing to do it, so he came and took Audrey
to the dance. Audrey was stunned. “This was truly a
night to remember, and I don’t think I’ll ever fully
wrap my mind around it,” she wrote.

Holly was very thankful, because the last year had
been so difficult for them.

When interviewed, Harris said he was simply trying
to be human. “Trying to take off the helmet, trying to
take off the cape of what I do professionally and

show some sympathy for that family and try to show
some support there,” he explained.

Bus Driver Saves Passengers

A school bus stalled on the railroad tracks in Illinois,
and was hit by a passing train, but the passengers
were already safe.

The local fire department received a call that the
vehicle had stalled on the train tracks. The bus driver
had stopped for the tracks, as required, but when
she tried to move across the tracks and continue her
route, the bus stalled out. A train was approaching,
and the gate came down on top of the hood of the
bus. Thinking quickly, the bus driver escorted the
five students off the bus and moved them to a safe
distance from the tracks.

The Fire Chief explained that no one was hurt,
thanks to the quick actions of the bus driver.

Coast Guard Rescues 18 From Ice Floe

The United States Coast Guard and a good
Samaritan successfully rescued 18 people who were
on an ice floe that separated from shore.

The mass rescue was conducted on February 6 in
Ohio after snowmobilers became stranded on the
floe, according to tweets from Coast Guard Great
Lakes.

Dustin, an Air Taxi pilot, saw that there were people
on the ice of Lake Erie near Catawba Island, and
that the ice had broken, leaving them on a floating
ice shelf with no way to get back to shore. He
radioed in to the Coast Guard, saying, “There’s a
huge crack that’s just opened up. There’s a bunch of
guys stuck on the wrong side of the crack, can you
guys go check on them?”

The Coast Guard sent out a helicopter and a rescue
boat. In the following hours, they rescued all 18

Good Words, Good Deeds, Good News
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people who had been stranded. No one fell in, and
no one required medical treatment.

The Coast Guard urged people to “take precautions,
not chances” when engaging in recreational
activities on the ice. ”Remember to dress
appropriately for the water temperature, not the air
temperature; to wear a life jacket and carry a reliable
form of communication; and to carry icepicks or
screwdrivers that can help them self-rescue if they
go through the ice,” the release said.

10 Year-old Assembles Chemo Comfort Bags to
Honor Grandfather

Sophie, a fifth-grader from New York, was very close
to her grandfather, Terry. She was his only
granddaughter, and they spent a lot of time together,
with him telling her family history stories or taking
her for rides in his red Corvette.

He was diagnosed with pancreatic cancer, and was
in the midst of his treatments, telling her about the
treatments and why patients have such a hard time.
It was then that she got the idea to assemble Chemo
Comfort Bags, which contained pillows, blankets —
some of which her great-grandmother crocheted —
cozy socks, snacks, tea, and games. She made ten
of them, and donated them to the Roswell Park
Comprehensive Cancer Center, where Terry was
receiving treatment. Sadly, he passed away shortly
after that.

Sophie intends to keep making the comfort bags,
and wants to donate 20 by the end of March in
honor of her grandfather’s March birthday.

95 Year-old Veteran Writing Third Children’s
Book

In 1942, just four months after Japan attacked Pearl
Harbor on December 7, 1941, a young Sam Baker
enlisted in the Marine Corps. He served at
Guadalcanal, and was discharged in 1947, joining
the U.S. Coast Guard and Geodetic Survey— which
became the National Oceanic and Atmospheric
Administration (NOAA) — where he worked for 30
years before retiring.

A few years ago, with his son’s encouragement, he
wrote his first children’s book, named The Silly
Adventures of Petunia and Herman the Worm, which
was published in 2018. Oscar the Mouse was
published in 2020, and he’s writing another now, at
age 99, to be published this year.

Couple Adopts Baby Left At Police Station

A couple named Ben and Gina have four older
children, but when they decided to become foster
parents, they got some exciting news.

In 2020, a baby was left at a police station, the
mother apparently being aware of the Texas Safe
Haven Law.

“The Safe Haven law, also known as the Baby
Moses law, gives parents who are unable to care for
their child a safe and legal choice to leave their
infant with an employee at a designated safe place,”
according to the Texas Department of Family and
Protective Services (DFPS) website. “Remember, If
you leave your unharmed infant at a Safe Haven,
you will not be prosecuted for abandonment or
neglect,” the DFPS website noted.

When they were called, Ben and Gina rushed to buy
some necessities, and picked up the baby girl, who
they named Hope. They adopted her soon after.

Social media posters also praised the mother for
leaving the baby in a safe place so she could be
cared for.
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by Paul Arnote (parnote)

I hate it when developers try to make things “simpler,” especially when something
has been one way for a very, very long, LONG time. That’s the case with the
most recent Firefox 98.0.1. Developers, in their misdirected zeal to “simplify” the
download workflow, managed to ROYALLY screw it up. Hey, I’ve been using it
ONE WAY for so many years, and now the download workflow isn’t doing what I
expect or what I’ve become accustomed to. I literally have adapted Firefox’s time-
honored “download workflow” to the way I work, and the new way is a HUGE
disruption to the way I work.

Grrrrrrrrrrrrrrrrrr!

So up until the “update” that brought Firefox 98 to my desktop, Firefox would ASK
me what I wanted to do with certain download links. Did I want to open it in
Firefox? Did I want to open it in an associated program? Did I want to download
it? And then I would tell Firefox what I wanted to do with that particular download
link.

But, very recently, Firefox started just doing those download actions without first
asking me. All of a sudden, I found PDF files opening in Firefox (not what I
wanted!), and all sorts of other download links taking on a mind of their own,
doing exactly what I didn’t want them to do, but what Firefox thought I would want
to do with them. So much of the time, what Firefox “thought” I wanted to do with
them was completely off the mark.

Fortunately, it’s pretty easy to return the new, “delinquent” download workflow
behavior to the old, tried-and-true “standard” behavior.

First, go to the “hamburger” menu (upper right corner of Firefox toolbar), and
select “Settings” from the menu. Within the “General” settings, scroll down until
you find the “Applications” section. This is the section that tells Firefox what to do
with the different download data types that you might try to download. Review
each entry, because this is where the “royal screw up” has happened.
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To change it back to the standard download workflow behavior, click on the
“Action” in the rightmost column. Choose the default action you want Firefox to do
when you download that particular type of file. For me, that choice is to “Always
ask,” which gives me ultimate control over what to do with each file I download.
And, sometimes, I want the file to open in Firefox, sometimes I want to save it to
my hard drive, and sometimes I want the file to open in some other application.

See. It’s simple! Now you have the default download workflow behavior that
Firefox has always had since, it seems, time immemorial. While the newer
“simplistic” way of handling downloads might work for some users, it shouldn’t be
a “one-size-fits-all” proposition. There are those of us who still need control and
choice.

Sorry Mozilla developers. You can’t take choice away from us today!

The PCLinuxOS Magazine
Special Editions!

Get Your Free Copies Today!

Firefox Tried To Simplify The Download Workflow. Here's How To Change It Back.

http://pclosmag.com/special.html
http://www.linuxfoundation.org/


PCLinuxOS Magazine Page 34

Screenshot ShowcaseScreenshot Showcase

1. All the contents of The PCLinuxOS Magazine are only for general
information and/or use. Such contents do not constitute advice
and should not be relied upon in making (or refraining from
making) any decision. Any specific advice or replies to queries in
any part of the magazine is/are the person opinion of such
experts/consultants/persons and are not subscribed to by The
PCLinuxOS Magazine.

2. The information in The PCLinuxOS Magazine is provided on an
"AS IS" basis, and all warranties, expressed or implied of any
kind, regarding any matter pertaining to any information, advice
or replies are disclaimed and excluded.

3. The PCLinuxOS Magazine and its associates shall not be liable,
at any time, for damages (including, but not limited to, without
limitation, damages of any kind) arising in contract, rot or
otherwise, from the use of or inability to use the magazine, or any
of its contents, or from any action taken (or refrained from being
taken) as a result of using the magazine or any such contents or
for any failure of performance, error, omission, interruption,
deletion, defect, delay in operation or transmission, computer
virus, communications line failure, theft or destruction or
unauthorized access to, alteration of, or use of information
contained on the magazine.

4. No representations, warranties or guarantees whatsoever are
made as to the accuracy, adequacy, reliability, completeness,
suitability, or applicability of the information to a particular
situation. All trademarks are the property of their respective
owners.

5. Certain links on the magazine lead to resources located on
servers maintained by third parties over whom The PCLinuxOS
Magazine has no control or connection, business or otherwise.
These sites are external to The PCLinuxOS Magazine and by
visiting these, you are doing so of your own accord and assume
all responsibility and liability for such action.

Material Submitted by Users
A majority of sections in the magazine contain materials submitted by
users. The PCLinuxOS Magazine accepts no responsibility for the
content, accuracy, conformity to applicable laws of such material.

Entire Agreement
These terms constitute the entire agreement between the parties with
respect to the subject matter hereof and supersedes and replaces all
prior or contemporaneous understandings or agreements, written or
oral, regarding such subject matter.

Disclaimer

Posted by OnlyHuman, March 9, 2022, running Enlightenment.
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Serves 6

Ingredients:

Bread Pudding

8 cups cubed (day old) French bread (1-inch pieces)
4 eggs
2 cups half-and-half
3/4 cup packed brown sugar
1/4 cup butter, melted
1 teaspoon vanilla
1/2 cup toffee bits

Topping

1/2 cup caramel topping
1/4 teaspoon vanilla
Whipped topping, if desired

Directions:

Generously spray 5- or 6-quart oval slow cooker with
cooking spray. Place bread in a slow cooker.

In a medium bowl, beat eggs and half-and-half with
whisk until well mixed. Add brown sugar, melted
butter and 1 teaspoon vanilla; beat until well mixed.

Pour over bread; toss to evenly coat in custard
mixture. Let stand for 10 minutes. Toss again to
make sure as much of the custard mixture as
possible is soaked up by bread. Press down slightly
on top of bread, and sprinkle with toffee bits.

Cover top of insert with large
kitchen towel folded in half.
Place the lid on top of the towel.
(This will prevent condensation
from dripping onto bread during
cooking.) Cook on Low heat
setting 2 1/2 to 3 hours or until
edges are golden brown and
temperature is at least 160F
when instant-read thermometer
is inserted near center.

Meanwhile, in a 1-cup glass
measuring cup, mix caramel
topping and 1/4 teaspoon
vanilla. Serve with warm bread
pudding. Top with whipped
topping.

Nutrition:

Calories: 630 Carbs: 83g
Fiber: 1g Sodium: 530mg
Protein: 12g

PCLinuxOS Recipe Corner Bonus

Slow-Cooker Caramel-Toffee Bread Pudding

http://pclinuxoshelp.com/index.php/Main_Page
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SCRAPPLER RULES:
1. Follow the rules of Scrabble®. You can
view them here. You have seven (7) letter
tiles with which to make as long of a word
as you possibly can. Words are based on
the English language. Non-English
language words are NOT allowed.
2. Red letters are scored double points.
Green letters are scored triple points.
3. Add up the score of all the letters that
you used. Unused letters are not scored.
For red or green letters, apply the
multiplier when tallying up your score.
Next, apply any additional scoring
multipliers, such as double or triple word
score.
4. An additional 50 points is added for
using all seven (7) of your tiles in a set to
make your word. You will not necessarily
be able to use all seven (7) of the letters in
your set to form a “legal” word.
5. In case you are having difficulty seeing
the point value on the letter tiles, here is a
list of how they are scored:

0 points: 2 blank tiles
1 point: E, A, I, O, N, R, T, L, S, U
2 points: D, G
3 points: B, C, M, P
4 points: F, H, V, W, Y
5 points: K
8 points: J, X
10 points: Q, Z

6. Optionally, a time limit of 60 minutes
should apply to the game, averaging to 12
minutes per letter tile set.
7. Have fun! It's only a game!

SUDOKU RULES: There is only one valid solution to each
Sudoku puzzle. The only way the puzzle can be considered
solved correctly is when all 81 boxes contain numbers and the
other Sudoku rules have been followed.

When you start a game of Sudoku, some blocks will be prefilled
for you. You cannot change these numbers in the course of the
game.

Each column must contain all of the numbers 1 through 9 and
no two numbers in the same column of a Sudoku puzzle can
be the same. Each row must contain all of the numbers 1
through 9 and no two numbers in the same row of a Sudoku
puzzle can be the same.

Each block must contain all of the numbers 1 through 9 and no
two numbers in the same block of a Sudoku puzzle can be the
same. D
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Possible score 255, average score 179.

PCLinuxOS Puzzled Partitions

http://pclosmag.com/html/Issues/202204/files/2022-04-PuzzleSolutions.pdf
http://www.scrabblesite.com/scrabble/rules/
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AWNING BACKYARD

BASKETBALL HOOP BENCH

BIRDBATH CARPORT

COMPOST BIN DOG HOUSE

DOWNSPOUT DRIVEWAY

FENCE FLOWER

FLOWER BED FRUIT TREES

GARAGE GARDEN

GUTTER HAMMOCK

HEDGES HERB GARDEN

HUMMINGBIRD FEEDER LAWNMOWER

ORCHARD PATIO FURNITURE

PLANTER PORCH SWING

SPRINKLER STEPPING STONE

STOOP SWIMMING POOL

SWING TERRACE

TRAMPOLINE TRASH CAN

TREE VEGETABLE GARDEN

VINE WADING POOL

WELCOME MAT YARD

Download Puzzle Solutions Here

N O N E D R A G E L B A T E G E V L B D B G M L H N Y Q Q L
C G Z H U M M I N G B I R D F E E D E R U G L G U B B U B O
A J E V Z J Q B N P B B B J K M T R A M P O L I N E D W E O
R S R B Y H S X B T Z K H N S B Z J I U W N I O C B X L N P
P W E D I X I S Z Y R T K I Q E Q C P R O E P J G W Z G C G
O I E U W V D T W C U E C B I R D B A T H B Z M P M B Y H N
R M R R D U W E K V A R E T T U G F N J O T A P V M U E Z I
T M U K V J C P G S A J S S D M W Y L O F S R C P Q W Q V D
A I T S Q P O P C N L I A O J L O Q G E O W J M K N X Z D A
M N I R F O R I Q W Z Q O P Q I S A Q W E I U P M Y F V N W
E G N E G R E N L L H X Y M N S Z R E J V N R I W R A Y R E
M P R W J C L G H W A W W O T I A J Q H C G Q K U N W R H I
O O U O G H K S T W W D B C Z V L R Q H S F K I A D N K D U
C O F M O S N T O B L K B Y V W A I W C L L T E B X I D L F
L L O N Z W I O J D C H D O A D J Z Y O P T W F I Y N T J I
E D I W E I R N V O Q O L R F F L O W E R B E D A I G X J U
W J T A U N P E M D O U D S I Y Z E L E T B K R E K Z G D F
R A A L N G S M J I O R J Q G V R O E T Z U D Z R F Y N V H
L U P I A U A K U P J G U I K P E S L X U S I Z W A O H I R
K I U Q Y H J X O B O B H L F X C W Y H C O D Q F U C H N C
H I U M Z B K D H K F Y Y O J L N A A D H Y P Q T Y L E E D
Q E D N H W H V S I Z C A Q U W E G P Y V N R S E M A P W N
G G R M E H S Q L L N H Z B H S F V L T I Z U G N D Y G G W
S N A B D B J F D K M D M O K Z E G A R A G Z F I W W U B X
T X H Q G V X F N Z N H F W M B P P N D A F Y E K L O V Z G
Z B C F E A A I F S J K U O G S J D T R A S H C A N I D R P
C Q R J S Z R E X J Q F Y K I T X R E P R Z W S V D F H U P
T I O R B S M D G N Z J H Z K O X W R D D W D Q N H T Z A X
Q T O X B A S K E T B A L L H O O P Y M P P W F U O P X A F
K G A R D E N B O N S G H D F P W X F F S W R C G P L S L F
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1. Place your patio furniture here to enjoy the

outdoors.

2. This is where all your favorite blooms are planted.

3. You can grow your own food here.

4. Lots of jumping and flips can be done on this.

5. Rows of fruit trees.

6. Great place to see the tiny wings moving so fast.

7. Lie in this for a lazy swing.

8. Waters the yard or flowers when it hasn’t rained.

9. Relax on these soft chairs.

10. Moves the rain from the roof to the ground.

11. Machine to keep the yard uniformly trimmed.

12. You can plant these and shape them for a barrier

between neighbors.

13. Plant some basil or chives here.

14. Like an umbrella for your window.

15. The kids can “dunk” the ball through this.

16. You can cool off in the water!

Download Puzzle Solutions Here

PCLinuxOS Puzzled Partitions

Back Yard Crossword
Hints rather than definitions... Word list is the word search list.
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Download Puzzle Solutions Here
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Mixed-Up-Meme Scrambler
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Posted by sam2fish, March 23, 2022, running KDE. Posted by The CrankyZombie, March 5, 2022, running KDE.

Posted by tbschommer, March 5, 2022, running KDE. Posted by parnote, March 8, 2022, running Xfce.
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